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Get out your camera!  The UO Web design committee
is soliciting photos for display on the UO Home Page at
www.uoregon.edu.

Call for Photos

The UO Computing Center recently added a new web proxy server that will dramatically speed
up your access to web resources. Because proxies store local copies of frequently-accessed web
sites, after the first viewing you won’t have to wait for a page to load from a very remote or slow
web server.  Instead, web sites you’ve already visited will load quickly from our local server,
proxy.uoregon.edu, which has more than 1300 MB of storage capacity.

How to use the proxy
Here’s how to enter the new proxy setting in each of the three most popular web browsers:

Netscape Navigator -

1. Open the Options menu and select “Network Preferences...”

2. Click “Proxies” and select “Manual Proxy Configuration.”

3. Click “View...”

4. In the “HTTP Proxy” field, type proxy.uoregon.edu

5. In the “Port:” field, type 3128

Netscape Communicator -

1. Open the Edit menu and select, in sequence, “Preferences,” “Advanced,” and “Proxies.”

2. Choose “Manual proxy configuration” and click “Configure...”

3. In the “HTTP Proxy:” field, type proxy.uoregon.edu

4. In the “Port:” field, type 3128

Internet Explorer 4.0 -

1. Open the View menu and select “Internet Options,” followed by “Connections”

2. Check the box labeled “Access the Internet using proxy server.”

3. Click “Advanced.”

4. In the “HTTP”  field, enter:  Address: proxy.uoregon.edu Port: 3128

New Proxy Server Means
Faster Web Browsing

© Disney

If you have taken, or would like to take, high-quality photos that capture life
around the UO campus, current UO events, or important campus personalities, we
welcome your contributions.

All photos that are chosen for display will include a credit to the contributor. Check out the
current home page to see the correct aspect ratio for your photo submission. The cropped size is 148
x 250 pixels. Each photo will link to another web page, which will include credit information and a
full-size version of the photo, as well as a brief description of the photograph. In general, photos
taken in portrait mode will work better.

Also, keep in mind that photos containing close-up shots of people will require their written
permission in order to be displayed on the home page. You can get a copy of the correct model
release form at www/photos/model_release.html.
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If you’re in the market for a new
modem and want the fastest possible
standard connection speed, you’re in
luck.  With the advent of “v.90,” it’s
now possible to achieve the highest-
speed 56K connection using a standard
modem—without  having to worry
about incompatibility problems.

Until now, having a 56K modem
was no guarantee of achieving the
fastest Internet connection because not
all 56K modems were compatible with
each other.  Now, however, as long as
both your modem and your Internet
service provider support v. 90, it’s
possible to use any 56K modem at its
highest speed.

How to determine
compatibility

If you’re buying a new modem,
you’ll want to make sure you’re

If you’re already running Mac OS 8.0, you’ll likely benefit from upgrading to Mac OS 8.1.
The latest version of the Mac operating system offers significant enhancements without

substantially increasing memory or disk space requirements.  Benefits include

• improved file caching • support for DVD drives

• increased overall performance • faster Java support

• better Windows 95 file format compatibility • miscellaneous bug fixes

Cautionary Notes:
1. HFS+ - Mac OS 8.1 offers a new file system format called HFS+ . While HFS+

promises to make disk usage more efficient in the long run, Microcomputer Services
staff currently does not recommend using it because there are as yet no disk utilities that
can repair a damaged HFS+  volume.  This means that if you encounter disk corruption,
data loss is much more likely.

2. Older Mac OS versions - If you’re running Mac OS versions earlier than 8.0,
upgrading to 8.1 is not recommended.

Questions?
For more information about Mac OS 8.1, see www.macos.apple.com  Or, direct your questions

to Microcomputer Services (email: microhelp@oregon.uoregon.edu; phone: 346-4412).

About
Upgrading
to Mac OS
8.1?

choosing one that’s compliant with
your standard connection.

To determine whether a modem is
compliant with a connection standard,
look at the packaging.  The standard
should be noted on the box.  For
example, boxes for 28.8K or 33.6K
modems should display the logo for
“v.34,” while 56K modem boxes might
display “v.90” and/or “X2” logos.

Connection standards
at the UO

The UO currently supports the
“X2” method of high-speed network
connection via modem. If all goes well,
v.90 connections should also be
available to campus dial-in users
sometime this summer.

In the meantime, if you’re
purchasing a 56K modem, play it safe
and opt for one that is both v.90- and
X2-compatible.

New 4mm
DAT Drive
Available

As noted in the previous issue of
Computing News, the VMScluster’s two
MTI 8mm tape drives are in the process
of being replaced by a new 4mm DAT
drive.  The old drives are gradually
being phased out and will disappear
entirely soon after June 15, when the
current maintenance contract expires.

In the meantime, the new 4mm drive
is now up and running on all VMScluster
systems, and those who are ready to use
it may do so.  To mount a tape on the
new drive, type

$ mount/foreign  mka10  123456

If you still haven’t converted to the
new 4mm tape format, there’s still time.
To ease the transition, the Computing
Center is providing free 4mm tapes to
users who currently have data on 8mm
media stored at the Center.

If you have further questions about
the conversion, send email to
system@oregon.uoregon.edu

A NEW STANDARD FOR 56K MODEMS:

v.90 Gets You Up to Speed

Thinking
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* WORKSHOP LOCATION CODES *
EC: Electronic Classroom  (Windows) 144 Knight Library
ITC:  Macintosh Classroom 2nd Floor, Knight Library
RSR:  Reed Seminar Room (Windows) 235 Knight Library

8 8 8 8 8 Requires an active account on DARKWING or GLADSTONE

The schedule for remaining spring term workshops in the IT Curriculum (Information Technology and Computer Workshops)
is presented below.

The IT Curriculum represents a joint effort by the University Library and University Computing to provide a full range of
computer and Internet training for everyone on campus.  These noncredit workshops are free of charge to all UO students,
faculty, and staff.  No advance registration is necessary, except where noted.  Seating is available on a first-come, first-served
basis; there are, however, two caveats:

• those who do not meet workshop requirements, such as prerequisites, may be asked to relinquish their place
• if fewer than five people are present ten minutes after the scheduled start, the workshop may be canceled at the

discretion of the instructor.
Requests for accommodations related to disability should be made to Jon Cawthorne (346-1897) at least one week in advance

of the workshop.

 Workshop Day/Date Time *Location* Presenter(s)

This schedule is subject to change.  See http://libweb.uoregon.edu/it/ for course outlines and the most current information

Electronic Research Resources

Net a Job: Use the Web  (Contact the Career Center, 346-3235, to register for this workshop)

Thu May 21 3:30 - 4:50pm EC Songer

Web Publishing (✔ Prerequisites for all)

 HTML Tools and Tricks  8 Tue May 19 2 - 3:50pm RSR Johnson
Beginning Photoshop for Web Publishers Thu May 21 1 - 2:20pm ITC Kim
Organizing Your Web Site 8 Tue May 26 2 - 3:50pm RSR TD Smith
Web Design for Users w/Disabilities Tue May 26 10 - 11:20am EC Bailey
Forms, CGI Scripts,  & JavaScript Thu May 28 9 - 10:50am RSR Johnson

Workshops on Video
If you don’t see the workshop topic you’re looking for, you might check out our video titles.  Media Services  (formerly the

IMC) in the basement of Knight Library and the Documents Room in the Computing Center (Room 205) have a growing
selection of videos on a variety of software packages and computing topics.

You may borrow these videos using your UO photo ID, or schedule a viewing room in Media Services.  Some videos are also
available for purchase.

Descriptions of these videos are available at micro.uoregon.edu/workshops  For more information, contact Media Services
(346-3091) or the Documents Room (346-4406).
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One of the easiest ways to fix a
computer software problem is to
reinstall the problematic program. But
what if the program that is causing diffi-
culties is the operating system itself?

While it’s relatively easy to reinstall
applications such as Microsoft Word,
Eudora or Netscape, reinstalling
Microsoft Windows 95, the Macintosh
Operating System (OS), or even
Windows 3.1 can prove difficult and
may not solve the problems the
computer is having. Many situations
actually call for a “clean” system
installation.

Routine vs. Clean
Routine: While a regular re-

installation of an operating system can
fix many OS-specific file errors, such as
a damaged Chooser extension on a Mac-
intosh or a corrupt Windows 3.1 printer
driver, many computer problems related
to the functioning of the operating
system will not be solved by simply
updating the existing system software.
The main reason for this is that many
files are not changed or updated by the
replacement  system. For example,

Macintosh Preferences files, Control
Panels or Extensions added by
applications and utilities that are not part
of the Mac OS will not be removed or
replaced during a normal system
reinstallation. Likewise, during a routine
system reinstallation, the Windows 95
registry (the backbone of the Windows
95 operating system) will not be purged
of incorrect entries or values.

Clean: A clean system installation,
on the other hand, completely replaces
the existing system with a brand-new
one. The downside to this rather drastic
operation is that the brand-new operating
system has no knowledge of any of the
applications that were already on the
hard drive, and many (if not all) of these
programs will need to be reinstalled.

On the positive side, a clean system
installation ensures that the operating
system will be in its most pristine
condition and will likely function
properly once rid of the offending file or
command. Reinstalling the applications
will bring the computer back to its
desired state, and errors will no longer
plague the operating system.

Performing a Clean System
Installation: Sometimes Starting
Over is the Best Approach

UO Still Among Top
Ten ‘Most Wired’

Variations in Clean
Installation Methods

Each operating system handles a
clean system installation a little
differently. Even the Macintosh OS,
which is by far the easiest system on
which a clean installation can be
performed, has three different installa-
tion methods, depending upon which
version of the OS is in use. The
Windows 95 procedure is fairly straight-
forward, but requires a foray into MS-
DOS to rename files and directories
before performing a clean installation.
Windows 3.1 is even more MS-DOS
dependent, with a series of file name
changes, directory creations, and system
file edits required to successfully
perform the clean installation.

While a clean system installation
sounds daunting, it doesn’t need to be.
With a little preparation and a clear un-
derstanding of the steps to follow, a
clean installation can take as little as 30
minutes on many systems. And if it
doesn’t work, the machine can always be
returned to its previous condition with
no harm done.

Need More Information?
For detailed instructions on perform-

ing a clean system installation specific-
ally for Macintosh, Windows 95, or
Windows 3.1 operating systems, consult
the Microcomputer Services web site at

micro.uoregon.edu/tips/cleaninstall
According to YAHOO Internet Life magazine, the University

of Oregon remains one of the top ten “most wired” colleges in the
nation, ranking ninth in America and third among public
universities.  Among other factors, schools in YAHOO's survey
were evaluated on their campuswide networks, email accounts,
Internet and web access, classes with online material and
assignments, and computer labs.

Others in the top ten included Dartmouth, New Jersey Institute
of Technology, MIT, RPI, Illinois-Urbana, Carnegie Mellon, Cal
Tech, Indiana University-Bloomington, and Worcester
Polytechnic.
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The replacement of the Computing Center’s old Xerox
4213 printers is now underway.  Two of the old printers
have been entirely phased out, leaving only one still in
operation until early July, and the new Xerox DocuPrint
N24 laser printers are now available.

You may access the new printers on the VMScluster as
queue SYS$DOCUPRINT, and on DARKWING, as printer
“docuprint.”

Features of the new printers
Among other features, the new DocuPrint laser printers

offer

• 24 page-per-minute print speed

• 600 dot-per-inch resolution

• a 100,000 page-per-month duty cycle

• duplex printing

• PCL 5e emulation with 45 fonts

• PostScript level 2 support with 35 fonts

Printer forms…

Ten printer forms are currently available, including

• DOCUPRINT_DEFAULT (for standard default
setup, or for PostScript and PCL jobs that perform
their own setup)

• PORTRAIT_66 (Courier, no top and bottom
margins, 66 lines per page)

• LETTER and LETTER_66 (for user-provided
letterhead)

• LANDSCAPE and LANDSCAPE_68 (landscape
orientation, Courier font)

• LEGAL and LEGAL_84 (legal paper, portrait
orientation, Courier font)

• LASER_LABELS (Avery 5160)

Note that the *_NO forms (no left margin) that existed
for the old printers are not available because the new
printers always require a left margin.
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Printer setup…

The duplexing unit, which enables two-sided printing,
has been installed.  Two-sided printing can be selected via
DCL by typing either

$ print/queue=sys$docuprint/setup=duplex_long
or

$ print/queue=sys$docuprint/setup=duplex_short

depending on whether you want long- or short-side binding.
You may also use the duplex feature for a PCL or PostScript
document.

Signature fonts…

Computing Center staff has digitized some signatures
into downloadable PCL fonts.  Those who wish to continue
using their own signatures will unfortunately have to have
them digitized again into a PCL font by Xerox, as there is no
way to convert the old XES fonts.  The cost for this service
is $135.

Need More Information?
If you need additional information about the new

printers, or wish to have a signature digitized for the
DocuPrint, send an email message to Rick Millhollin at

 rickm@oregon.uoregon.edu.

Xerox 4213 Printer Replacement Underway
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